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General OfficeTalk Features
The Bin  
The OfficeTALK Bin lets you bin items in OfficeTALK which may be later un-binned or shredded 
completely.

OfficeTalk displays a bin in the following modes:

· Supervisor Mode
· Diary Mode

In Supervisor Mode you can bin the following items:

· Users
· Resources
· Groups
· Planners
· Projects

In Diary Mode you can bin the following items:

· Tasks
· Appointments

You can bin an item by dragging the item to the bin. To drag an item, press the left mouse button 
down when the cursor is over the item. Keep the left mouse button pressed and move the cursor over 
the bin . Finally release the left mouse button. The item will be removed from its original position and 
will be placed in the bin. If the bin contains any items then the bin will be displayed as shown below:

Bin with contents

You can display the contents of the bin by double clicking on the bin using the left mouse button. 
Alternatively, you may select Bin Contents from the View menu.
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Displaying the contents of the bin

 If you are in Supervisor Mode the following window will appear:

Bin Contents in Supervisor Mode

If you are in Diary Mode, viewing a user’s diary, the following window will appear:
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User’s bin contents in Diary Mode

If you are viewing a resource’s diary, the following window will appear:

Resource’s bin contents in Diary Mode

Un-Binning Items
OfficeTalk lets you un-bin items that you have previously binned. You can do this by popping up the 
Bin Contents Window, selecting the item(s) and pressing the  button. OfficeTalk will ask 

you to confirm this action. Press  to un-bin the item(s).
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User Confirmation

Shredding Items
OfficeTalk lets you shred items that you have previously binned. You can do this by popping up the 
Bin Contents Window, selecting the item(s) and pressing the  button. Shredding an item 
will delete it completely from the OfficeTalk database. OfficeTalk will ask you to confirm this action. 

Press  to shred the item.

User Confirmation

Name Style
OfficeTalk lets you choose how you display the name of OfficeTalk users and Contacts. The following 
styles are available, shown below based on the name John Smith:

· John Smith
· John SMITH
· Smith, John
· SMITH, John
· Smith, J
· SMITH, J
· J. Smith
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· J. SMITH
· Smith
· SMITH
· John
· Login Name (OfficeTalk users only)

OfficeTalk lets you choose one style for displaying OfficeTalk user’s names and another style for 
displaying OfficeTalk contact names. Changing the OfficeTalk user’s and/or contact’s name style will 
affect the display of OfficeTalk users and/or contacts in all areas of the application.

To change the name style of either OfficeTalk users or contacts, do the following:

Œ Bring up the General Preferences dialog box by selecting General Preferences 
from the Options menu.

General Preferences dialog box

 Press the  button. The Name Style dialog box will appear.
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Name Style dialog box

Ž    Select either the Users or Contacts radio button depending on which style you wish 
to define. Select one of the style radio buttons according to how you wish to display
the users or contacts. If you select the Contacts radio button you will not get the 
option to choose a login name for the name style since login names are applicable 
only to OfficeTalk users.

    Press . The name style will be remembered for future login sessions.
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The Toolbars
There are two toolbars in every mode in OfficeTalk. These toolbars are referred to as the main toolbar 
and the sub toolbar. Initially the size of these toolbars is large with text. The main toolbar is aligned 
along the top of the application and the sub toolbar is aligned along the left side of the application. 

You can change both the size and position of these toolbars individually. Changing the size and/or 
position of either the main or sub toolbar will change the size and/or position of these toolbars in every 
mode within OfficeTalk.

Changing the Size of the Toolbars
You can choose between the following toolbar sizes/styles for the main toolbar:

· Large with text
· Large
· Small
· Hidden
· Tab Bar

· Colour
· Black/Grey

 You can choose between the following sizes for the sub toolbar:

· Large with text
· Large
· Small
· Hidden

To change the size/style, select Toolbars from the View menu or from the right mouse button menu in 
any mode within OfficeTalk.
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The Toolbars menu command

The Toolbars dialog box will appear.

Toolbars dialog box

The dialog box lets you specify the size of the two toolbars individually. An example of the different 
sizes and styles of toolbar is shown below: Note that the Tab Bar representation is only available for 
the main toolbar.

Large with text

Large
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Small

Tab Bar

Moving the Toolbars
OfficeTalk lets you align both the main toolbar and the sub toolbar to any side of the window. If you so
wish, you may also make the toolbars float above the application window. These are Windows™ 
standard dockable toolbars.

To move the toolbars, press the left mouse button down while the cursor is over a part of the toolbar 
but not over a toolbar button. Whilst keeping the left mouse button pressed, drag the toolbar to the 
required position on the screen. You will be dragging an outline of the toolbar. If you drag the toolbar 
near to one of the edges of the screen, the toolbar outline will snap itself to the relevant edge. 
Releasing the left mouse button will cause the toolbar to relocate to the new position. If you release the
mouse button when the cursor is in the middle of the main window, the toolbar will relocate itself to 
float in the middle of the screen above the application windows.

OfficeTalk will use the toolbar positioning in all modes and will remember the positioning between 
sessions.

ToolTip Help on Toolbars
If you move the cursor over a particular button on the toolbar and keep it there for a short time, a label 
will appear underneath the button, describing the action of the button. 

This label is called a ToolTip. You can disable ToolTips by unchecking the Tool Tips check box in the
Toolbars dialog box.
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Toolbars dialog box

Printing

You may print many of the views that OfficeTalk provides. The list of printable views is as follows:

· Daily Appointments
· Weekly Appointments
· Monthly Appointments
· Task List
· Group Chart
· Group Week-at-a-glance
· Projects
· Planners
· Contacts
· Companies
· Conversations
· Mail

All Print dialogs have several buttons in common which provide functionality for setting up the printer,
previewing what you are about to print, defining headers and footers and specifying paper styles. 
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Setting Up The Printer
Every Print dialog box has a  button. Pressing this button will bring up a Print Setup dialog 
box. This dialog lets you choose which printer you wish to use.

 

Print Setup dialog box

You can choose either the default printer or a specific printer from the list of printers. Since this dialog 
is standard to most other Windows applications, it also lets you choose the orientation and size of your 
paper. OfficeTalk does not use this functionality since paper orientation and size is defined in 
OfficeTalk's Paper Style dialog box (See Paper Styles later on in this chapter). 

If you press the  button, another dialog box will appear which will be specific to the 
particular printer that you have selected.

Previewing
OfficeTalk lets you preview (view on the screen) anything that you are about to print. This saves you 
paper and time. To preview, pop up the relevant Print dialog box, by pressing the  button above the 
corresponding window. The Print dialog box will appear. Press the  button. OfficeTalk will 
then display a preview of the print out.

Headers and Footers
Headers and footers are the areas above and below the top and bottom of the print range on a page, 
respectively. These area are typically used for printing titles, page numbers etc. 
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OfficeTalk provides a  button in every Print dialog box. Pressing this button will bring 
up a Headers and Footers dialog box.

Headers and Footers dialog box

OfficeTalk lets you define left, centre and right justified headers and footers, using the six fields in the 
Headers and Footers dialog box. You may insert any text in these fields. You may also insert certain 
substitution codes to give you additional print time information. The substitution codes available to 
you are as follows:

·    %p Page number
·    %t Total number of pages
·    %r Row number for xy printing
·    %l Column number for xy printing
·    %D Current date
·    %T Current time
·    %% Percent sign
·    %u OfficeTalk user
·    %c OfficeTalk workgroup name

When a view has a date/time associated with it, the following substitutions may be used: 

·    %a Abbreviated weekday name
·    %A Full weekday name
·    %b Abbreviated month name
·    %B Full month name
·    %d Day of month as a decimal (01-31)
·    %H Hour in 24 hour format (00-23)
·    %I Hour in 12 hour format (01-12)
·    %j Day  of the year as a decimal (001-366)
·    %m Month as a decimal (01-12)
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·    %M Minute as a decimal (00-59)
·    %W Week of the year (00-51)
·    %y Year without century (00-99)
·    %Y Year with century
·    %Z Time zone abbreviation if known

Extra substitutions are:

·    %s Section letter (company/contact, e.g. A, B ...Z)
·    %o Owner of a schedule/tasklist
·    %n Name of a project/group/planner
·    %S Start date for range print
·    %s Start time for range print
·    %E End date for range print
·    %e End time for range print

· Example

The following text could be put into the footers field:

Printed by %u on %D at %T

If you print using this text in your footer field then OfficeTalk will 
print for example:

Printed by Joe Smith on 21/02/95 at 14:10

You may choose to use this example substitution on all OfficeTalk print outs. If you check the Line 
below Header check box then a horizontal line will be drawn below each header. If you check the 
Line above Footer check box then a horizontal line will be drawn above each footer. You may choose 
between having a header on the first page only or having a header on all pages. Similarly, you may 
choose between having a footer on the first page only or having a footer on all pages.

You can specify the fonts for the header and footer using the  button and the  
button. The header and footer fonts will apply only to the Print dialog from which this dialog was 
invoked. Once defined, the font settings will remain persistently until they are changed.

Paper Styles
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When printing you must always tell OfficeTalk the paper style that you wish to print on. A paper style 
describes the size and orientation of the printed view. It also lets you divide a page into sub pages 
which OfficeTalk will treat as if they were pages in their own right. 

OfficeTalk comes supplied with several pre-defined paper styles. These are as follows:

· A4 Portrait
· A4 Landscape
· A4 Landscape (2 rows x 2 Cols)
· A5 Landscape
· A5 Portrait
· Envelope
· Filofax® 2 pages Landscape
· Filofax® 2 pages Portrait

You can select a paper style from within any Print dialog box by choosing the relevant style from the 
Paper Style pull down list. 

You can create or edit paper styles by selecting Paper Styles from the Print sub menu in the File 
menu. When you select this menu option, the Paper Styles dialog box will appear. You can create a 
new paper style by pressing the  button. Alternatively, you can edit an existing paper style 
by selecting the paper style from the list and pressing the  button. In both cases a Paper 
Styles dialog box will appear.
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Paper Styles dialog box

The Paper Sizes fields define the printable area in terms of width and height. You may choose from a 
list of existing paper sizes or you may select Custom (at the bottom of the list) and specify your own 
Paper Width and Paper Height.

The No. of Rows field and the No. of Columns field define how the page is to be divided into sub-
pages. The default is No. of Rows = 1 and No. of Columns = 1 which means that the page is not split 
into sub-pages. 

The Page Margins and the Internal Margins may be used to completely define the printable area of 
the page (and/or sub pages). The diagram below summarises each measurement.

Top Page Margin

Bottom Page Margin

Left Page Margin

Right Page Margin

Bottom Internal Margin

Top Internal Margin

Left Internal Margin

Right Internal Margin

Cutlines

Sub-Page

· Example
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If you wanted to print out some OfficeTalk contacts onto sheets of 
labels (4 across x 8 down) then you would set No. of Rows = 8
and No. of Columns = 4. You would then specify the internal 
margins according to the size of the labels.

The Draw Cutlines check box draws lines representing where you should cut along if you wanted to 
cut the printout into its individual sub-pages. For example, if you used the Filofax® 2 pages Landscape
paper style, which comes supplied with OfficeTalk, you would probably want OfficeTalk to draw the 
cutlines so that you could cut out the two filofax sized pages from your single A4 sheet of paper.

You can specify the orientation of the paper by selecting either the Portrait or Landscape radio 
button. This will automatically instruct the printer to use either landscape or portrait.

Linking Information
OfficeTalk lets you link items of many different types together, allowing you to easily associate one 
piece of information with another. For example, you may need to do a particular task as a result of a 
conversation that you had with a particular contact. OfficeTalk will let you link together the task, the 
conversation and the contact so that you can quickly access each piece of information from the other.

OfficeTalk lets you link information belonging to other users, provided that you have access to their 
information. For example, you may send a mail message to somebody requesting that they do a task 
that you have entered for them in their task list. You may wish to link your copy of the mail message 
to their task, letting you find the task quickly to see if it has been completed.

How to link two items together
To link, for example, an appointment to a task, select the appointment from the Daily Appointment 

Window and press the  button above that window. Next, select the task that you wish to link to and 

press the  button above the Task list. 

Notice that when you have pressed the link button once, all other link buttons will change to indicate 

that OfficeTalk is expecting you to finish the link. When you press the second  button to finish the 
link, all link buttons will change back to their original appearance.

You can use the menu to link items together. The Link menu contains the following commands:
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Links Menu

To connect one end of the link, select the relevant OfficeTalk item and choose Start Link from the 
Links menu. Next, to connect the other end of the link, select the other OfficeTalk item and choose 
Finish Link. The items will now be linked together.

Cancelling a Link
To cancel a link making operation, select Cancel Link from the Links menu.

Deleting Links
To delete an existing link, select one of the items at one end of the link and select Delete Links from 
the Links menu. All links attached to the selected object will be deleted.

Viewing Links
Any item within OfficeTalk (e.g., task, appointment, conversation etc.) that is linked to another item 
will be displayed with a  marker shown next to it. You can view all the items that a particular item is
linked to by clicking on the marker using the left mouse button. A list of links will drop down below 
the  marker. You can goto any of the links shown by clicking on the relevant link in the list, using 
the left mouse button.

List of drop down links
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When you select one of the links from the list, OfficeTalk will change to the relevant mode and display
the item in the view.

If any of the items in the list of links have other links themselves, then OfficeTalk will indicate this by 
displaying an arrow symbol down the right margin of the link list next to the relevant link. You may 
view these links by clicking on the arrow using the left mouse button. When you click on the arrow, 
another list will appear, showing another set of links. You can goto any of these items in the same way 
as described above.

Showing link chains

How OfficeTalk uses links
In some cases, OfficeTalk will automatically create links to indicate to you that two items should be 
linked together. The following two cases involve OfficeTalk automatically creating links:

· When you create a follow-up task for a conversation, OfficeTalk creates a task in the appropriate 
task list and automatically creates a link between the task and the conversation.

· When you mail somebody a task, the mail message that they receive will be linked to the task in 
their task list.

Searching the Entire Database
There is a Search Database command in every mode in OfficeTalk in the Search menu. Choosing this
command will pop up the Search Database dialog box. This dialog box lets you search for text in the 
following OfficeTalk objects:

· Tasks
· Appointments
· Project Tasks



Chapter 11:   General OfficeTalk Features     19

· Received Mail
· Sent Mail
· Bulletin Boards
· Meetings
· Companies
· Contacts
· Conversations

Search Database dialog box

Enter the text that you wish to search for in the Text field. If you wish the search to be case sensitive 
(i.e. take into consideration uppercase and lowercase) then check the Case Sensitive check box.

By default, when searching the entire database, OfficeTalk will only search the main text of an object. 
For example, in the case of appointments, only the appointment text will be searched and appointment 
notes will be ignored. In the case of conversations, only the subject of the conversation will be 
searched. In the case of mail, only the subject of the mail message will be searched. In the case of 
companies and contacts, only the name of the company or contact will be searched. If you want 
OfficeTalk to search all aspects of any object then check the Search All Text check box. When this 
check box is checked, OfficeTalk will search any note text associated with appointments, tasks, 
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companies and contacts. It will search the contents of all received mail messages, sent mail, bulletin 
boards and conversations. It will also search the agenda of meetings. The table below summarises how 
the search differs according to whether the Search All Text check box is checked or not:
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OfficeTalk item Search All Text not 
selected

Search All Text selected

Tasks description searched description, classifications, notes
Appointments description searched description, notes
Project Tasks description searched description, classifications, notes
Received Mail subject searched subject, message body
Sent Mail subject searched subject, message body
Bulletin Boards subject searched subject, message body
Meetings subject, place searched subject, agenda
Companies name searched name, all address lines, comment, 

phone numbers, email address, 
notes

Contacts name searched name, phone ext, position, 
department, mail, comment, notes, 
entire home address.

Conversations subject searched subject, conversation body

The effect of the Search All Text check box

By default, OfficeTalk searches for objects beginning with your search text. If you wish to search for 
objects containing your search text then select the Contains radio button prior to performing the 
search.

OfficeTalk provides several options regarding which types of data will be searched. There is a check 
box for each data type. You have the option of excluding a particular data type from the search by 
unchecking the relevant check box.

For the task and appointment data types you have a further option of choosing whose tasks and 
appointments you wish to search. By default, OfficeTalk will search your personal appointments and 
tasks. You can instruct OfficeTalk to search all users tasks or appointments by selecting the All Tasks 
or All Appointments radio button. You can also instruct OfficeTalk to search a particular user’s tasks 
or appointments. You can do this by selecting the Belonging To radio button next to the Tasks or  
Appointments check box. Then select the particular user from the pull down list of OfficeTalk users.

You have the choice of searching either the OfficeTalk database or searching the results of the last 
search. You can search the results of the last search by selecting the Search Results radio button. By 
default, the OfficeTalk will search the OfficeTalk database.

When you have specified your search criteria, you can now perform the search by pressing the
 button. OfficeTalk will search through all the data types that have been selected in the 
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dialog box. The status bar of the dialog box will update you with the progress of the search. When the 
search is complete, the number of matched records will appear to the right of the dialog box status bar. 
The results of the search will be placed into the Results window. 

You can view any of the items in the Results window by selecting that item from the Results window 
and pressing the  button. OfficeTalk will remove the Search Database dialog box, change to
the relevant mode and will load the selected record into view. The results held in the Search Database 
dialog box will not be lost. When you next select Search Database from the Search menu, the results 
of the last search will be listed in the Results window.

OfficeTalk lets you remove individual records from the Results window. You can do this by selecting 
the relevant record and pressing the  button. You can remove all records from the Results 
window by pressing the  button.

Working Remotely
Introduction
OfficeTalk has the facility to let you copy certain portions of the OfficeTalk database onto a local hard 
disk and continue using OfficeTalk as if you were connected to the shared database. This is extremely 
useful, if you have a portable computer and spend most of the time away from the office but still wish 
to benefit from the shared data offered by the main database.

Working Remote
To work Remote, select Work Remote from the File menu from within any mode.
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Work Remote

When you select this the Disconnect To dialog box will appear. Enter the pathname for the 
disconnected database. OfficeTalk supplies a default path. Press .

Disconnect To dialog box

OfficeTalk expects a directory path which does not exist. If the specified directory already exists, 
OfficeTalk will confirm with you that it is OK to remove the directory and all its contents.

OfficeTalk Confirmation
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If you choose that you do not wish to delete the directory, OfficeTalk will redisplay the Disconnect To 
dialog box. Otherwise the Disconnection Options dialog box will be displayed.

Disconnect Options dialog box

The Disconnect Options dialog box lets you select which parts of the OfficeTalk database you wish to 
take remotely. By default, OfficeTalk assumes that you wish to take your own diary and the Program 
files. Selecting these default options will copy your appointments and tasks in addition to any personal 
projects, groups, planners and mail. The program files will also be copied and a new Program Manager
group, OfficeTalk Remote, will be created if the Copy Program Files check box is selected.

To copy other users diary information, select the Other Diaries radio button. The  button 
will be enabled. Press this button to bring up the Disconnect Diaries dialog box.

Disconnect Diaries dialog box
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From the Unselected Users list, select the users whose diaries you wish to copy for working remotely. 
Press the  button to move these users into the Selected Users list. You can use the

 button to remove selected users from the Selected Users list. The  button will 
remove all users from the Selected Users list.

To copy public planners, public projects, resource information, meeting information, contact 
information, and conversations (only if contact information selected) check the corresponding radio 
button in the Disconnect Options dialog box. If you select the Contact Information check box, 
OfficeTalk will copy all companies and contacts for the entire workgroup. Selecting this check box 
will also enable the Conversation Information check box, giving you the choice of taking all the 
conversations for the entire workgroup.

When you press , OfficeTalk will copy the relevant information to your local drive. When 
this is complete, OfficeTalk will display the following message:

OfficeTalk Message

When you press  on the information box, OfficeTalk will log you off and the application 
will close down. The next time you log on, you will not connect to the main database, but instead you 
will log on to the copy of the database that you have just made.

Using OfficeTalk Remotely
When working remotely you may do everything that you might do when connected to the main 
database, except you may not delete items which existed prior to time that you disconnected from the 
main database.

Even if you do not select to copy certain parts of the OfficeTalk database, you may still add records to 
these databases. For example, if you do not copy the contacts database, you may still add contacts, 
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companies and conversations. These records will be added to the main database when you attempt to 
reconnect with the main database.

Sending Mail Messages While Working Remotely
While working remotely, you may send mail messages as normal. If you send a mail message to 
another OfficeTalk user then the message will be stored until you reconnect to the main database at 
which point it will be delivered. You may send mail messages to other OfficeTalk users, user groups 
and bulletin boards.

If you send a mail message to a VIM or MAPI recipient, OfficeTalk will try to communicate with the 
VIM or MAPI messaging immediately. If your VIM or MAPI message database is not held locally, 
then OfficeTalk will not be able to send the message. You will be informed of this. OfficeTalk will not
buffer the message. You must resend the message when you have access to the MAPI or VIM 
messaging system.

Updating the Main Database
If you wish to update the main database with your modifications but want to remain working offline 
and it is not important that you receive changes from the main database then instead of Working Online
and then Working Remote, you may select the command Update Main Database from the File menu.

Update Main Database Command
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 This will effect any changes that you have made, whilst working remotely, onto the main database. 
When you select the command, OfficeTalk will confirm that you wish to update the main database.

OfficeTalk Confirmation

Working Online
If you wish to reconnect to the main database, bringing with you all changes made whilst disconnected,
then select the command Work Online from the File menu.

Work Online command

 OfficeTalk will confirm that you wish to reconnect to the main database.
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OfficeTalk Confirmation

When OfficeTalk reconnects with the main database, all mail messages to other OfficeTalk users will 
be delivered. OfficeTalk will also attempt to add or modify all other data which you changed since 
disconnecting.

Handling Clashes
Sometimes, OfficeTalk will find change clashes where you have modified some data that has also been
modified on the main database since you disconnected. If OfficeTalk finds any clashes, then during the
reconnection process, OfficeTalk will pop up a series of dialog boxes. Each dialog box will represent a 
change clash for a particular field in a particular record. Each dialog box will display the data in the 
remote database and the corresponding data in the online database. Both Remote and Online fields will 
have a radio button beside them. Selecting the Remote field radio button will indicate that you wish to 
use the data from the remote database. Selecting the Online field radio button will indicate that you 
wish to use the data from the main database. The data that you choose, according to which radio button
you select, will appear in the Result field. Once you have made your choice, press  to 
continue with the reconnection process.

The following shows some examples of the dialog boxes which may appear if certain clashes occur 
during the reconnection process:
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Task Description Clash

Task Private Clash

Task Start Time Clash

Task Duration Clash
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Task Complete Clash

Contact Position Clash

Company Postcode Clash



Chapter 11:   General OfficeTalk Features     31

Choosing The Startup Mode
By default, when you start OfficeTalk, you begin in Diary Mode with the Daily Appointments Window
displayed. OfficeTalk lets you change which mode you begin in when you start the application. 
Further, OfficeTalk lets you choose which view, within that mode, is shown initially. You can do this 
in the following way:

Œ Select Startup Mode from the Options menu.

Selecting Startup Mode

 The Startup Mode dialog box will appear:

Startup Mode dialog box
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Ž Select which mode you wish to start up in by choosing one of the leftmost 
radio buttons. Then, for each mode containing multiple views, select which of 
those views you wish to begin in when you enter the corresponding mode by 
selecting one or more of the indented radio buttons. Press  to apply
the selection and  to cancel the operation.
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